Operation Manual

for

Delta Flight Attendants & Pilots

VERSION 5

Revision: April 30, 2018
# Table of Contents

- **GENERAL INFORMATION** ................................................................. 4
  - Contacting Product Support................................................................. 4
  - What you need to download ................................................................ 4
- **SETUP ................................................................................................ 5**
- **EMPLOYEE INFORMATION .................................................................. 6**
  - Add Employee Name ............................................................................. 6
  - Select the User ....................................................................................... 6
- **CALENDAR MENU BAR - Miscellaneous Items** .................................. 7
  - Calendar Procedures .............................................................................. 7
  - Edit ...................................................................................................... 8
  - Month ................................................................................................... 8
- **BID PACKAGE - Download from DELTANET ....................................... 9**
  - PILOTS .................................................................................................. 9
  - FLIGHT ATTENDANTS ......................................................................... 13
- **PROCEDURE FOR USING THE MONTHLY BID PACKAGE .................. 18**
  - NAVIGATING THE CALENDAR ............................................................ 24
    - How Rotations Are Displayed on the Calendar .................................. 24
    - Placing Rotations on the Calendar ....................................................... 25
    - Calendar Display of City IDs .............................................................. 26
  - ROTATION DISPLAY – The Bid Assistant Format .................................. 27
    - Carryout Rotation Display .................................................................. 27
    - Removing a Rotation From The Calendar ........................................... 28
    - Editing Calendar Date Information .................................................... 28
- **CALENDAR EVENTS ............................................................................ 29**
  - Adding Work Events ............................................................................ 29
  - Adding Flight Attendant A-Days ............................................................ 29
  - Reduce Time .......................................................................................... 31
  - Personal Comments .............................................................................. 32
  - Editing a Comment or Event Banner on the Calendar .......................... 33
  - Placing a Pilot Reserve Line on the Calendar ......................................... 36
- **SORT ROTATIONS PROCEDURE – database ....................................... 40**
- **SEARCH REQUEST Function ............................................................... 40**
- **SELECTION LIST – Saving Favorite Rotations ..................................... 40**
- **BUILD CALENDAR Function ................................................................. 42**
  - Placing Rotations on Build Calendar and Saving the Calendar ............ 43
  - Miscellaneous BUILD CALENDAR Controls ....................................... 44
  - Checking for 30 in 7 Legalities on the Build Calendar .......................... 44
  - SELECTION LIST Trip #’s Shown on Full Calendar ............................. 45
- **TRANSITION ROTATIONS – Month-End Trip Changes ....................... 46**
  - Manually Check for Transition Change ................................................ 46
  - Transition Change Conversion ............................................................. 46
  - TRANSITION and NEW Rotations Added to Database ......................... 50
- **CANCELLED ROTATIONS .................................................................... 49**
  - Work Rules for Cancel no repl .............................................................. 49
  - Cancelled Removed - Orange Banner Reminder .................................... 50
- **ADD–EDIT ROTATION ......................................................................... 51**
  - Matching iCrew Information to the ADD–EDIT Rotation Display ......... 52
  - Putting Bid Package Information into the ADD–EDIT Display ............. 53
  - ADD–EDIT Rotation Screen - Overall Display ........................................ 54
  - The Rotation Leg Edit Screens ............................................................. 55
  - EDITing Rotations – Step by Step ......................................................... 56
  - EDIT a Rotation that is on the calendar ............................................... 57
  - ADDing a NEW Rotation by Copying an Existing Rotation .................... 57
  - Using a Blank Rotation Entry Screen .................................................. 59
- **HOTEL DATABASE ................................................................................ 64**
- **TIME CALCULATOR ............................................................................ 65**
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROGRAM UPDATES - Downloading</td>
<td>66</td>
</tr>
<tr>
<td>Windows Vista and Win7</td>
<td>65</td>
</tr>
<tr>
<td>Windows 10</td>
<td>65</td>
</tr>
<tr>
<td>PERSONAL EVENTS – Birthdays, Anniversaries, etc</td>
<td>69</td>
</tr>
<tr>
<td>MONTHLY ALERTS</td>
<td>70</td>
</tr>
<tr>
<td>MAXIMIZING the Calendar Screen</td>
<td>71</td>
</tr>
<tr>
<td>PRINTING OPTIONS</td>
<td>74</td>
</tr>
<tr>
<td>PRINT CALENDAR</td>
<td>75</td>
</tr>
<tr>
<td>Print Calendar with Rotation Information</td>
<td>75</td>
</tr>
<tr>
<td>Yearly Calendars - prints a year of calendars</td>
<td>75</td>
</tr>
<tr>
<td>Print Rotations Only</td>
<td>75</td>
</tr>
<tr>
<td>Post-It Notes</td>
<td>75</td>
</tr>
<tr>
<td>Build Calendar Print Options</td>
<td>76</td>
</tr>
<tr>
<td>EMAILING CALENDAR – Convert to PDF</td>
<td>75</td>
</tr>
<tr>
<td>Finding and Installing Bullzip PDF Printer Software</td>
<td>75</td>
</tr>
<tr>
<td>Using Bullzip PDF Printer</td>
<td>80</td>
</tr>
</tbody>
</table>
BID ASSISTANT
OPERATION MANUAL

GENERAL INFORMATION

ABOUT:
The Bid Assistant program is designed to help the user evaluate monthly rotation files and catalog them to specific preferences for bidding. Included in the program is a monthly calendar that can be used to display your awarded rotations. The program is designed for two users – Flight Attendant/Flight Attendant, Pilot/Pilot or Pilot/Flight Attendant.

The program is a stand-alone program. The only connection you need is an Internet connection to the DELTANET web site for downloading the monthly Bid Package. Google Chrome or FireFox should be used to download the Bid Package as Internet Explorer often assigns an unusable file name. The downloading process is accomplished by the user and explained in this operation manual. Note: Chrome has been known to not download the bid package correctly on some computers. If you have this problem, use FireFox

Program updates
Program Updates are available on the Bid Assistant web site www.ghale.com. The various program improvements are designated by dates. Each update available on the web site updates the previous functions of the program. The Update of the program you are operating is shown in the upper right corner of the calendar. If this date does not agree with the date of the Update on the web site, you will want to download the latest Update to keep your program current. Instructions for downloading and unzipping the program updates are available on the home page of the web site and in this manual.

Contacting Product Support
Before you request technical help, check the Bid Assistant web site and check the date of the last program revision. The program updates are named by the date they were revised. Download the latest revision to see if your problem has already been addressed. The “What’s New” button explains any changes to the program. If you still have a problem with the program, use the “Program Support” button located on the web site.

What you need to download
For Bid Assistant to display and sort monthly rotation information and be able to construct a calendar with your awarded trips, you will need to download the Bid Package for your base from Deltanet every month (p.9,13).

Instructions for downloading this file are available in this manual. When the program begins, it will look in the download location you entered in the Bid Assistant Setup screen to find the Bid Package. The program will prompt you to confirm use of this Bid Package by showing its name (DTW330 MAY or dtw_jun2017) and then place it in the correct folder of your computer.

The Bid Assistant rotation display is a more user friendly color coded design that includes the hotel phone numbers. A hotel database is included with the program and can be updated from www.ghale.com.
Entering Values in the Setup screen

SETUP
When you start the program for the first time, a Setup screen will display. This information entered is used by the program to determine the type of Bid Package to look for (FA, Pilot, aircraft, base, month, year). You will also tell the program where it can find the rotation file or Bid Package you downloaded. The Setup information can be changed for each, if two users. In the Calendar Procedures menu, select the user then select the option Bid Assistant Setup.

Click the Calendar Procedures menu at the top of the screen to access the setup screen when running the program.

The setup screen is divided into various data entry blocks.

- **Program Information area**: This area contains employee’s information describing your position and base.

- **Local Time**: Local Time = 1:00 pm

- **Military Time**: Military Time = 13:00

- **Rotation Download Location**: The download location tells the program where to look for the Bid Package you downloaded from DELTANET. The default and recommended location is the C:\BID_ASST3 folder.

- **Bid Assistant Setup**: Click on the C:\ Highlight the BID_ASST3 folder. This is the default location set by the program.

- **Time Format**: When adding a rotation to the calendar, the program will verify the city/hotel information is in the database. If not, it will ask you to enter a city name for the city ID displayed. If you do not want to use this feature, leave this box unchecked.
The Employee Information data is used by the program to determine what rotation file to look for. This information is used by the program to set up the various folders for the user. The employee information is the same for pilots and flight attendants except for the extra information supplied by the pilots.

**EMPLOYEE INFORMATION**

To Add or Delete an employee, click the Edit menu on the setup screen.

**Add Employee Name**
You can have two different people using the program. After two people have been added, this feature will be grayed out until you delete one of the employees from the setup screen.

**Delete Employee Name**
This feature will allow you to delete an employee from the setup screen. Deleting the employee will remove all files saved belonging to this employee. Selecting Delete Employee Name will display a list of the employees using the program. Select the user to delete from the list.

**Select the User**
When the program is started, the calendar for the last user to use the program will display.

**Calendar Procedures > Select User** allows you to change between users. The current active user will be grayed out. In this case, GREG is the active user.
Calendar_Procedures

- **Select User** - allows the display of another user’s calendar (p.6).

- **Sort Trips** - Provides the use of the database procedures.  **Note:** Only available for calendars that have the Bid Package downloaded for the displayed month (p.38).

- **Available Rotation List** - Displays a list of rotation files available for the displayed calendar (p.25).
  - **No Rotations Available** - Displays if the rotation files for this month are not available.

- **Hotel List** - Displays a list of hotels on file. Each time a rotation is placed on the calendar, the hotel information for each rotation day is compared to the hotel list. If the hotel is not on the list, the hotel and city can be added (p.62).

- **Print** - Various printing capabilities are available for printing the displayed calendar (p.72).

- **Print Setup** - Allows customizing the print function.

- **Bid Assistant Setup** - Displays the setup screen for adding, editing, and deleting employee information, including your base (p.5). This is also where you can enter **Personal Events** that occur one time or yearly such as birthdays, anniversaries, Holidays, etc. These are displayed in red italic print next to the date (p.67).

- **Save Changes** - Appears when any changes have been made to the displayed calendar.

- **Remove Old Calendars from Computer** - Provides a listing of calendar files saved on your computer. This provides the ability to remove old calendars from your computer. You can select multiple files on the list to remove. The files are labeled using the Month and Year to describe the rotation file.

- **Check For Month End Transition Trips** - Allows the checking for month transition rotation changes for the displayed month. This feature is usually displayed after a new rotation file has been expanded and placed in the correct month/year folder on the computer (p.46).

- **Remove Configuration File** – The Configuration File contains information you supplied on the Setup screen. Removing this file will require you to fill in the Setup screen again at program start up.

- **View Complete Rotation Text File** - Displays the complete list of rotations used for the displayed bid month.

- **CONVERT BID PACKAGE** – Sometimes a new Bid Assistant Update may require you to **Convert** the Bid Package again so you can see and use the corrections and improvements. If the original PDF Bid Package was used to show the calendar, this function will recreate all the rotations published in the Bid Package. This option will not remove the existing month calendar or remove the existing Transitions and NEW rotations or remove any **ADD-EDIT Rotations** or any rotations on the Main Calendar you edited for a specific date. And you do NOT have to be online for it to work (p. Error! Bookmark not defined.).

- **Exit** - Closes the program.
CALENDAR MENU BAR - Miscellaneous Items

- **EDIT NOT AVAILABLE** – This message appears only if a specific date does not belong to the displayed bid month.

- **EDIT -> Month Day** - Available when a calendar day is selected and the day belongs to the displayed bid month. Provides a screen for editing the data shown on that calendar day.

- **ADD-EDIT Rotation** - Provides a way for adding new rotations and for making changes to rotations in the Available Rotation List (p.51).

- **CALENDAR EVENTS** - The procedure allows entry of work events: *a-days, vacation, training, other and personal events* to the calendar (p.29).

- **Edit Month Totals** - If the monthly credit total shown at the top of the calendar is not correct, a screen is provided for changing this value. *Monthly Credit = The sum of all time values displayed on the calendar (INCLUDING the carry-in value of a trip from the previous month).*

- **Time Calculator** - Displays a unique calculator for the program. The calculator has the ability to add, subtract, multiply and divide decimal values and time values. It can easily convert from one to the other (p.63).

- **Monthly Reminders** - Provides a screen to add notes for the displayed calendar. These notes are used for viewing and not sent to the printer. When data is entered to the Monthly Reminders, an additional icon is displayed at the top of the main calendar to the left of the Month selection block.

- **General Notes** - Same as Monthly Reminders except notes are not month specific. An additional icon is displayed to the right of the Month selection block at the top of the calendar.

- **Monthly Alerts** - This is a note box that displays on program start up specific to the month displayed (p.70).

- **Printed Calendar Notes** - These are notes displayed on the “Calendar with Rotations” printout. These notes appear to the right of the calendar frame.

- **Edit Banner** – Allows you to change the information shown in a Comment Block, Work Events, A-Days banner. Does not apply to Rotation banners.

- **EDIT Rotation** – Allows editing an existing rotation information displayed on the calendar.

- **Delete A-Days/Work Events/Comment/Rotation** - Available for a highlighted calendar day that has a Comment Block, Work Events, A-Days or Rotation number attached to the bottom of the calendar day.

**Month**

Allows selecting the calendar to show from a list instead of using the month selection arrows at the top of the calendar.
**BID PACKAGE - Download from DELTANET**

**PILOTS**

The contents of this page are for the use with the Bid Assistant program only. Any reference to the DelTanet is for reference only. The Bid Assistant program is not associated or sponsored by Delta Airlines.

**Google Chrome or FireFox should be used to download the PDF file to your computer.**

For Bid Assistant to be able to build a rotation database for a specific month, the Bid Package for your base, and aircraft must be downloaded to your computer's C:\BID_ASST3 folder. The program, when started, will look on your C:\BID_ASST3 folder for any new rotation files downloaded. If a Bid Package is found, Bid Assistant will use this file to build rotation database. If you download to another place on your computer other than the C:\BID_ASST3 folder, Bid Assistant will not find this file unless you change the Bid Assistant Setup’s Download Location to reflect this location or you move the file to the C: drive.

1. Log in to DELTANET & select Company

2. Select Flight Operations

3. Select Crew Resources/Scheduling.

4. Select Monthly Bid Packages
This example is for retrieving the ATL 330 bid package for April.

*This example is using Win10*

Select your **BASE, FLEET, and MONTH**.

---

**NOTE:**

There are 3 bid packages available for the 330. Some of the larger aircraft will have “A” (*captain*) & “B” (*first officer*) selections as shown above for the 330. All other aircraft will have two bid package to select. In either case you want to download the PDF bid package.

When there are 3 bid packages to select from, you should **select the bid package that does not** have the “A” & “B” attached to the package’s name.

---

After you make your selection and select the PDF file, the PDF rotation file will display on the screen.

---

**ATLANTA**

330

PILOT BID PACKAGE

April 2017

---

Since there are several different ways a PDF file could display on your computer’s screen. **Right click on the displayed bid package and select Save As**.
Save Bid Package in the C:\Bid_Asst3 Folder

Most computers will not be setup to download to the C:\Bid_Asst3 folder. You will need to change the Save As: block. The following example uses Win10 operating system. Although the displays may be different, the procedure is the same.

The Bid Assistant program will look in this folder for your downloaded bid package at startup.
Make sure the bid package you are downloading matches the Base & Aircraft shown on the Bid Assistant Setup screen.

Click [Save] to download the bid package.

When the bid package has downloaded, this tab will show in the Status bar.

After the tab has shown in the Status bar, close this window.

The bid package will display in the Bid_Asst3 folder.

This completes the bid package download. You can close all windows then start the program. The program will find the file and convert it.
FLIGHT ATTENDANTS

The contents of this page are for the use with the Bid Assistant program only. Any reference to the Deltanet is for reference only. The Bid Assistant program is not associated or sponsored by Delta Airlines.

Google Chrome or FireFox should be used to download the PDF file to your computer.

1. Log in to DELTANET
2. Click My Tools
3. Click “iCrew”
4. Sign in to iCrew
5. Click “Bid Package” (2 methods shown)
6. Select “Click Here”
NOTE: At this time the Atlanta rotations are in 2 PDF documents – ATL1 & ATL2. Both need to be downloaded and saved in your computer for both to be converted by the program.

For those not interested in ATL2 bid package rotations, Bid Assistant has the ability to Convert only the ATL1 bid package.

Note: The ATL2 bid package cannot be converted without the ATL1 bid package. Both must be converted at the same time.
Save Bid Package in the C:\Bid_Assist3 Folder

Depending on the computer operating system, the procedure for displaying the PDF file could vary. The following applies to Windows Vista computers.

After selecting the bid package from the previous page, you may get a warning message.

You then may then see a screen asking you to select the program.

You may get one more screen asking **Do you want to open this file?**
After selecting the Atlweb1 bid file, the PDF file will display on your screen. The size of the file could vary the time it takes for the bid file to display. Depending on your PDF display, look for the Save icon and click on it.

Some PDF files have a menu bar at the top, select the “File” menu then “Save As”. On other PDF files, you may need to hover your mouse at the bottom center of the displayed PDF file and select the File icon that displays.

Wrong Location
Usually, when you select to save the PDF file, the Save In: box will show an incorrect download location.

You will need to change the Save In: location to the correct location – C:\Bid_Assist3

Select the Computer or My Computer icon to display the drives on your computer.
You are now in the correct location to save the bid files.

Note the Save In box now shows the Bid_Asst3 folder.

The bid file's name atlweb1 displays in the file name window.

Click the [Save] button to save the file.

Use this same procedure to download the 2nd ATL Bid Package if you wish to use it. All the other bases, at this time, require you to download only one Bid Package. The program will look in the folder shown on the Setup screen's download location. Make sure the Setup screen's base and download location match the base and location where you are actually downloading the Bid Package.
New procedure for using the downloaded Bid Package

Some browsers are not including the *.pdf extension with the bid package filename. If this is the case, the bid package will not be a selection on the BA_PDF to Text screen. Exit the BA_PDF to Text program and start Bid Assistant. Bid Assistant will correct the filename of the bid package. You will then need to close Bid Assistant and start the BA_PDF to Text program to convert the bid package if you wish to use the Alternate Method.

The internal conversion program supplied with the Bid Assistant program is used to convert the PDF bid package to a TXT file so the program can read the downloaded bid package. This internal conversion program has been causing errors during program operation. This mainly affects the Flight Attendant’s large bid packages. Although the Pilot’s smaller bid packages have been running correctly, they could also have this problem if their bid packages grow in size.

I am providing an “Alternate Method” for converting this bid package to a usable format. If errors display during or after the program converts the bid package or you notice rotations that did not display correctly using the “Default Method” (which is what you have been using in the past), you will be able to start over and use the “Alternate Method” which should provide an error free formatting of the rotations in the bid package.

Both methods do not change the way you download the bid package to the program’s download folder. Download the bid package to the download folder then run the program as you normally would, using the “Default Method” and allow it to convert the bid package automatically.

If the program had trouble formatting any rotations in the bid package or you noticed that rotations did not display correctly using the Default Method, use the Alternate Method.

Alternate Method

- Exit the Bid Assistant program
- Download the bid package again to the program’s download folder
- Using the instructions on the following pages, run the BA_PDF to Text program and manually convert the PDF bid package to a Text file.
- Close the BA_PDF to Text program and start the Bid Assistant program.
- Select the “Alternate Method”.

The bid package that was found

Select the method for using the bid package

Click [Submit] to continue with your selection

Although both methods are available, it is recommended that you start using the Alternate Method. The Alternate method has been through extensive testing of all the bid packages from Delta and is formatting the rotations correctly without error. It is up to the user’s discretion on which method to use, but if errors are made in the formatting of the rotations using the Default Method, you will need to download the bid package again and use the Alternate Method for that bid package. Reference “Transferring Bid Package for Alternate Method” page 23.
Procedure for Manually converting the PDF bid package to a Text file

If you have not installed the **BA_PDF to Text** program on your computer, the installation is available on the Bid Assistant “Download” web page. This is a new program and not part of the Bid Assistant program.

If the Bid Assistant program is running, close the program before running the **BA_PDF to Text** program. This will allow the Bid Assistant program to find the converted bid package and its created *.txt file when you restart the program.

Locate the **BA_PDF to Text** shortcut on your desktop and select it to start the program.

The following instructions use the Flight Attendant bid package.
Setup the display and select the bid package to convert.

**Important**: The 4 steps below are required to have the “BA_PDF to Text” program generate a usable bid package.

1. **Uncheck** View text file
2. **Select** Raw Order
3. **Uncheck** Page breaks
4. Click on this top button to show your computer’s files and folders.

Select the (C:) drive

Then select the `Bid_Asst3` folder to see the bid package.

**NOTE**: The C:\Bid_Asst3 download folder is the suggested folder for downloading the bid package. If you use a different folder, locate and open that folder to view the bid package file.
The PDF bid package will show in the C:\Bid_asst3 folder.
(this example is using the dtw_jan2018 bid package)

Verify these selections have been set.

Select the bid package you downloaded from Delta.

Selecting the [Open] button will place the bid package on the BA_PDF to Text screen.

Verify the correct bid package was selected.

Verify these selections have been set.

Click the [Convert] button to begin the conversion of the bid package.

Flight Attendants: You do not convert the “TR” file.

.PDF designates the bid package file.
When the bid package conversion is complete, the “Progress/Generating” display will disappear from the screen.

You have now successfully converted the PDF bid package to a Text file. No further action is required. Select [Close] to close the BA_PDF to Text window.

Start the Bid Assistant program and select the Alternate Method on the selection screen. The program will automatically find the converted bid package.

**Flight Attendants:** If your base has 2 bid packages available for the month, you must convert each bid package separately before using them in the Bid Assistant program.

- **Flight Attendants:** You do not convert the “TR” file.

Both bid packages must be converted one at a time. Convert #1 allow it to convert (generate), then select the #2 bid package and convert it.

The conversion process for the ATL bid packages could take longer than normal because of the size of the bid package.
**Transferring Bid Package for Alternate Method**

If you use the *Default method* for the bid package and a list of rotations did not format correctly or rotations are not displaying correctly on the calendar, you were required to go back to Delta and download the bid package again so you could use the Alternated method. To eliminate having to go back to Delta, a new selection has been added to the *Calendar_Procedures* menu called “*Transfer bid package for Alternate Method*”. This will place the PDF bid package you downloaded from Delta back into the program’s download location.

After you have been advised that the transfer is complete, close the *Bid Assistant program* and use the *BA_PDF to Text* program to convert the bid package. Then start the Bid Assistant program again and select the *Alternate Method*.

Any formatting errors that occur using the Default Method can be corrected by Alternate Method.
Changing the Month Displayed on the Calendar
Clicking the arrows on either side of the calendar month title at the top of the calendar or pressing the PgUP or PgDN keys on the keyboard will change the month displayed. Clicking the arrows on either side of the calendar year title at the top of the calendar will change the year displayed.

Highlighting a Calendar Day on the Calendar
Moving around the calendar is accomplished by clicking your mouse pointer over one of the calendar days, or pressing the UP, DOWN, LEFT, RIGHT arrows on your keyboard.

A menu bar is provided at the top of the calendar to provide various operations of the calendar.

Copying Data From One Day To Another
The Drag/Drop method is used for copying information between calendar days.
1. Move the cursor over the information to copy.
2. Hold the CONTROL key down then press and hold the LEFT mouse button on the calendar day to copy.
3. Move (drag) the cursor to the day into which you wish the information pasted
4. Release the mouse button and the Control key to drop the information on the calendar day.

Displaying Rotations on the Calendar
Double clicking the left mouse button or pressing the [ENTER] key on a calendar day that has a rotation assigned to it, will display that rotation. A Calculator button is available for displaying the Time Calculator (p.63) while viewing the rotation. To print the rotation, click on the [PRINT] button located on the rotation display.

How Rotations Are Displayed on the Calendar

When a Rotation is dropped on or placed into a Calendar, Bid Assistant can have it display the 3-digit city code or the complete city name. Calendar Procedures > Bid Assistant Setup sets this Show City Information option. Bid Assistant also has a Hotel database (p.62).

Anytime a rotation's new city/hotel combination is placed on the calendar, an entry box will be displayed to allow you to enter the full name of the city. This information will be used for future city/hotel placements on the calendar.
Placing Rotations on the Calendar

Each month when you download your Bid Package of rotations from DELTANET, Bid Assistant will convert it to place rotations into the Available Rotation List for the correct month(s) for use in the Main Calendar and in the Search Request and Build Calendar functions. The Available Rotation List is in Calendar Procedures on the menu bar.

To place a rotation onto the calendar, open the Available Rotation List, search for your trip number, click and HOLD your LEFT mouse button and drag the rotation number onto the date it operates, then release the mouse button.

When the "insert rotation" dialog box appears, click the YES button to insert the rotation on the calendar. For this example, we are going to place rotation #6231 on October 18.

After placing the rotation on the calendar and selecting Yes on the displayed message, the rotation will appear on the calendar. If the rotation carries over into the next month, a special carry-over rotation display will show you the current month’s credit value and the next month’s. The Bid Assistant Calculator will be available to help you verify the times if needed.

Click and hold your LEFT mouse button over the rotation number on the list. Still holding the mouse button down, drag the rotation over the operation date on the calendar you wish to place the rotation and release the mouse button.

A rotation bar will display red when placed on the calendar. When the calendar is saved, the rotation bar's red color will change.

IDEA: Put your date's text information in a Personal Comment banner found in CALENDAR EVENTS.

1. You cannot place a rotation on a day that is not associated to the calendar bid month.
2. If you add a rotation on a date containing text in that date’s box, that text will be written over by the rotation’s info pertinent to that date.
3. You cannot place a rotation over an existing rotation or event.
Calendar Display of City IDs

Anytime you place a rotation on the calendar, the program will check to see if the city ID (HNL) has a city name (HONOLULU) on file. If not, a dialog box will appear for you to enter the name for this ID. Select the [Cancel] button to bypass this entry.

The program places this city name on file and will use the information when a rotation layover has this city ID. The ID is associated with the hotel present on that day. If more than one hotel is used for this city ID, you will be prompted to enter the city name for that hotel’s location.

The program will attempt to find a phone number for the rotation hotels on the calendar. Due to the way some of the rotations are formatted, the hotel may be abbreviated or reconfigured to fit the rotation display. In this case the program will not be able to find the hotel phone number. If a phone number cannot be determined, a list of hotels for that layover city will be displayed. Select the correct hotel from the list displayed. Once you have told the program the correct hotel name, you will not be prompted to find that hotel again. The program keeps the correct hotel name on file. If there is no match for the hotel, select the top item “EXIT LIST – NO MATCH FOUND”. This will place a “Phone N/A” on the calendar where the phone number should be. You can Edit the Hotel List and the date’s box to add the number later.

You can add the missing hotel to the list by selecting the Edit menu and then selecting Add Hotel to List. The Deltanet web site has a Hotel layover section or you can do a general search on the internet. Fill in all the data fields for the hotel. Selecting [SAVE] will place the added hotel into the Bid Assistant Hotel list (p.62). Then, when the rotation is placed on the calendar, you can select that hotel and the phone number will be placed on the calendar. It will also be available when you want to print the rotation display.

If the hotel is on the list, but a phone number is not displayed, select Edit Selected Hotel on the Edit menu to enter this hotel’s phone number.
ROTATION DISPLAY – The Bid Assistant Format

The Bid Assistant rotation display better organizes the information of Delta’s rotation display. Though the hotel phone number is not visible in this display, it will be included when the rotation is placed on the calendar or a print out of the rotation is requested. Double-clicking the rotation on the calendar or double-clicking the rotation number in the Available Rotations List will create this rotation display.

Pilot Rotation

Flight Attendant Rotation – includes SVC / LF column

Carryout Rotation Display
When a trip is placed on the calendar and it goes into the next month, the program will compute the rotation value for the current month displayed, and then compute the carryover time to the next month. The rotation will display on the screen and the values computed will be presented. A Time Calculator is available to help confirm these times.

When the values are correct, click the [Save] button. Selecting the [Cancel] button will terminate this rotation being placed on the calendar.

When a carry-over rotation is added, the program will automatically save the rotation to the calendar and the calendar will automatically be saved.
Removing a Rotation From The Calendar

Place the mouse pointer over one of the days on the calendar that the rotation resides. Click the RIGHT mouse pointer and select DELETE Rotation from the displayed menu. You can also highlight the day on the calendar and select DELETE Rotation on the EDIT menu at the top of the calendar.

Editing Calendar Date Information

Clicking the EDIT item on the displayed menu on the previous procedure will allow you to edit the information displayed on the calendar day. This information can be rearranged or changed to suit the user.

**NOTE:** The display window will use the existing fonts on the calendar to size the Hotel Information box. The program will limit the number of lines you can enter by referencing the size of the calendar’s day box size.

Clicking the Save button will place this information on the calendar.

**WARNING:** If this information is displayed on a day associated with a rotation, this information will be removed from the calendar when the rotation is deleted from the calendar.

The Notes block at the bottom of the display can be used to place information that does not need to be displayed on the calendar.

Clicking your right mouse button over either area will allow you to cut, copy, and paste the information displayed.

The [Hotels] button will display the hotel list. You can manually place the hotel information in the “Hotel Information” box.

This note will display when attempting to edit information that applies to an invalid day for the calendar bid month displayed. Select the month the rotation or information resides in to edit.

**NOTE:** To add a blank line between a day’s text, use the <Ctrl><Tab>, then press <Enter>.
CALANDER EVENTS

Calendar Events are used to show activities on the calendar that are not Rotations. All selections contain a time credit value except for the Comment option. The Comment option is used to place non work events on the calendar. The Calendar Events function is on the calendar’s Edit menu.

Adding Work Events
This section is used by pilots and flight attendants to insert work events and comments on the calendar.

Adding Flight Attendant A-Days
Select the date range for the A-Days
The automatic Credit value(s) calculate by the dates entered.

Editing Flight Attendant A-Days
All A-Day credit values can be edited. Right click the mouse over the A-Day to change and select Edit A-Day. The A-Day can also be deleted from this EDIT menu – select Delete >A DAY<.

If you modify the credit value for an A-Day, you will need to adjust the final A-Day's value in the A-Day block.
In addition to Rotations, other work events can be added by selecting the appropriate option bullet. All entries require a date range selected and a credit value entered in the Day Credit box - except for **Comment**. The program will automatically compute the number of days and the total credit value.

After selecting the Calendar Events from the Edit menu shown on the previous page, click an Event's bullet. The “Vacation” and “Training” events will automatically include the Day Credit for that event. In this example, we are selecting “Other Event”. Other Event contains events not normally used on the calendar, including things you wish to add.

Events that are not on the “Other Events” list can be manually added. Type the Event name in the green >>Enter Event<< box. If you wish to save this entry, click [Save Entered Event].

**Note:** Saving the event is not required to use it. If you would like to save the event to the list, select [Save Entered Event].
Reduce Time (Flight Attendants)
This procedure allows the user to reduce the Calendar’s Monthly Total due to unusual circumstances.

To reduce the Month’s Total, select the Reduce Time option.

After you have finished entering the required information for the Reduce Time function, select the [OK] button at the top of the display to save the time reduction. A description of what the reduced time you enter will display on the screen. Select [Yes] to place it on the calendar. Select [No] to go back to change the information.

A time reduction can be removed from the calendar. Right click over the reduction’s description and select [Delete Time Reduction].

Select [Yes] to remove the time reduction from the calendar and add that time value back to the Monthly Totals.

The Reduce Time feature is also available on the database’s Build Calendar procedure.
Calendar Events (continued)

Personal Comments

Placing Comments on the Calendar
The Comment option is used to place events on the calendar that do not have a credit value. These can be personal events, reminders, etc. Comments can be placed on any active day of the calendar. The program will allow 2 banners to be displayed on a calendar day – e.g., Rotation + comment, comment + comment. The program will not allow a comment to write over an existing comment or credit event. The default color for a comment is ‘light lavender’.

Selecting the “Comment” option will activate the Start, End and Enter Comment selections.

Select the dates for the comment. Type the comment title in the Enter Comment box.

Click [OK] to place the comment on the calendar.

Credits are not available on the comment event option.

The calendar will allow 2 comments to show on a single day or string of days. To place another comment on the calendar, use the procedure above to create the comment. If a second comment overlays any of the days of an existing calendar comment or credit event, the comment will be placed above the existing banner.

The second comment overlays an existing comment. Location of the first comment.

NOTE: UPPER comments cannot be added to the database build calendar. This is due to size constraints.

NOTE: When an Upper comment overlays an existing comment or credit event, any information in the affected calendar day box may need to be adjusted so it is not hidden by the upper comment.
**Calendar Events (continued)**

**Removal of Comments on the calendar:**
Clicking the right mouse button on one of the days of the calendar, will display a menu of choices for that day. You can Edit the selected comment or Delete it.

![Diagram of calendar with menu options for removing comments]

Notice the menu changes for the days shown. If two comments overlay a day selected, two choices per comment will appear. Selecting **DELETE** will remove that comment. If the ‘Lower’ comment is selected for removal and an ‘Upper’ comment overlays that comment, the ‘Upper’ comment will move down to the vacated space of the ‘Lower’ comment.

**NOTE:** If there is not enough room for the upper comment to fit in the vacated lower comment’s space, the upper comment’s position will not change.

When removing a comment, you will be asked if this is what you want to do.

When the ‘Lower’ comment (shown above) is removed, the ‘Upper’ comment automatically moves to the vacated space of the removed ‘Lower’ comment, unless another lower comment prevents its move.

**Editing a Comment or Event Banner on the Calendar**
Selecting **EDIT** will display a dialog box that will allow you to change the selected Comment/Event’s wording.

![Diagram of editing a comment]

If you add another comment that overlays a ‘Lower’ comment, the new comment will go on top of the ‘Lower’ comment.

*When a comment is added or moved on the calendar, there must be enough space on the calendar for the comment to be displayed. If there is not enough room, you will be advised of this so you can make corrections.*
Inserting a rotation or credit event on a day that has a comment

The Rotations and credit Events use the ‘Lower’ position to display their banner spanning the days of the event with the event name and credit. Rotation and credit Event banners take ‘Lower’ position priority over comment banners.

When placing a rotation on a day that has ONE (1) comment banner, the comment banner will move to the ‘Upper’ level allowing the rotation’s colored banner to occupy the ‘Lower’ level.

When placing a rotation on a day that has a ‘Lower’ and ‘Upper’ comment banner, you will be given 3 choices on how to handle this.

[YES] = Allow the program to move the lower comment. Selecting this will allow the program to move the ‘Lower’ comment up to the ‘Upper’ comment’s position. If an ‘Upper’ comment(s) exists, this action will remove that ‘Upper’ comment(s) from the calendar.

[NO] = Delete the lower comment -- Do not move up. This action will delete the ‘Lower’ comment from the calendar. If an ‘Upper’ exists, it will not be removed.

[Suggestion: You could combine the ‘Lower’ comment’s caption with the ‘Upper’ comment’s caption using the “Edit Comment Banner” procedure available on the calendar’s Edit menu or through right-clicking the date.]

[CANCEL] = Abort and make my own changes. This action will abort the addition of the rotation or credit event procedure and allow you to make changes to the calendar.

If NO ‘Upper’ comment exists and there is room for the comment to move up, the program will automatically do this without giving notice.

When a rotation is added to the calendar and more than one lower comment banner will be affected, the program will advise you to correct this. Only one comment banner can be moved up.

Deleting a Rotation or Event:

When deleting a rotation from the calendar and a comment exist above it, the upper comment’s banner will move down to the location of the rotation’s banner if there is enough room for the upper comment to display. If there is not enough room for the upper comment banner to move down, the upper comment banner will remain in its original position.
Since rotation #8505 will overlay a ‘Lower’ comment, you will be given several choices for handling this.

Selecting [CANCEL] will abort the procedure and allow you to make changes to the calendar.

Selecting [NO] will delete the ‘Lower’ Comment and leave the ‘Upper’ Comment(s) alone.

Selecting [YES] will remove the ‘Upper’ comment(s) and move the ‘Lower’ comment up.

Since there are two ‘Upper’ comments associated with the dates of the rotation, this message will appear. If you select [Yes], both ‘Upper’ comment banners will be removed to allow the ‘Lower’ comment to move up.

Both of the ‘Upper’ comment banners were removed and the ‘Lower’ comment banner was moved up.

After adding a rotation/credit event to the calendar, if the ‘Upper’ comment overlays data on one of those calendar days, a reminder message will appear to correct the day’s information.

In this case, the Report time was covered up by ‘Upper’. The date’s information has been edited so Report time will no longer be hidden by the banner.

**NOTE:** To add a blank line between a day’s text, use the <Ctrl><Tab>, then press <Enter>. 
Calendar Events (continued)

Pilot Reserve

The reserve calendar event is for Delta pilots. It allows the placement of awarded reserve days on the calendar either singularly or as a block. No credit value will be added to the Calendar’s Monthly Total since a reserve line is based on a guarantee pay for the month. In addition to the standard reserve days, the "Short Call" event may also be placed on the calendar over an existing reserve day or any non credit calendar day. The Short Call has a value of 1:00 if a pilot does not fly that day. If a pilot is awarded a rotation that lays over any reserve or short call day(s) on the calendar, those reserve/shortcall events will be removed to allow the rotation to display on the calendar. If a Short Call is removed, the daily value of the Short Call will be removed from the Calendar’s Monthly Total and the credit value for that rotation will be added to the Calendar’s Monthly Total.

If a pilot chooses to add the guaranteed monthly credit on the calendar, selecting <Edit><Edit Monthly Totals> will allow this entry.

After you have been awarded a reserve line, place the reserve days on the calendar.

### Placing a Reserve block on the calendar:

1. **Activate the Reserve Event** by selecting “Pilot Reserve”
2. **Select the type of Reserve event you wish to place on the calendar.**
3. **Select the Start and End days of the block of reserve days.**

After selecting the reserve type and the date range, Click [OK] to place reserve days on the calendar.
Calendar Events (continued)
After selecting [OK], you will be asked to verify the entry to be placed on the calendar. Selecting [Yes] will place the entry on the calendar. Selecting [No] will cancel the entry.

The reserve days will be placed on the calendar with a Fuchsia colored banner.

Placing a “Short Call” event on the calendar:
Short Call events are placed on the calendar like a reserve day. Short Calls can be placed over an existing Reserve day or a calendar “non credit” day.

Select “Short Call”

The daily credit value for the Short Call. This value can be changed by entering a new credit value.

Select the Start and End days of the Short Call day(s).

The Short Call banner will be a bright green with the daily credit value. **(This credit is added to the Monthly Total)**

Note: The award line included a “Jury Duty” obligation. This is shown in this example using the “Other” calendar event procedure.
Assigned or awarded rotation can be inserted over an existing block of reserve day(s).

**Placing a rotation over a reserve day:**
In this example rotation #4436 was assigned on February 8th. When the rotation is dropped on an existing reserve/shortcall day, all reserve/shortcall days that are affected by this rotation entry will be removed to accommodate the rotation display. If a Short Call day is affected, the Short Call credit value will be removed from Calendar’s Monthly Total.

Verify you wish to place this rotation over the reserve days.

Reserve days on the calendar not affected by the rotation entry are still displayed on the calendar.
SORT ROTATIONS PROCEDURE – database

The database procedure is available on any calendar that has rotation files available for that displayed month. The database provides the ability to find and view specific rotations from the Bid Package. A BUILD CALENDAR function is provided for testing different rotation combinations for bidding. The database procedure is presented in a Tabbed format. Initially the SEARCH REQUEST features are displayed. Selecting the BUILD CALENDAR tab will change the display. The tabs offer the ability to switch back and forth between the Search and Build screens.

To sort trips, use Calendar Procedures > Sort Trips > Build Rotation Database. If the database has already been built, select Show Rotation Database.

To delete the database files generated, select Remove Rotation Database. This is useful if you want to remove database files no longer needed. The program automatically does this after it adds New & Transition Rotations.

Two screens (tabs) are available with the database procedure, the SEARCH REQUEST and the BUILD CALENDAR.

The SEARCH REQUEST display is used to find rotations specific to the search request parameters you select.

The BUILD CALENDAR will allow you to use all rotations to build or construct various calendar rotation combinations. In addition, you can add other pay events like Vacation, A-Days, CQ and non-pay comment banners. Many different BUILD CALENDAR combinations can be made and saved with various printing options.

Clicking on the tabs will display the desired screen. Data displayed on one tab will not change when selecting a different tab to display. For example, while building a calendar, you calculate you only need a rotation worth 9:00 to 17:00, so simply tab to Search Request, search for Rotation Credit range 0900 to 1700, add trip(s) found to Selection List, then return to the calendar you are building and test adding the new found rotation(s).

Flight Attendant Database Only:
Aircraft Type = Select to show rotations for a particular aircraft.
SEARCH REQUEST Function

SELECTION LIST – Saving Favorite Rotations

A List Options button is under the Selection List. Right-clicking over the Selection List box will also display the List Options for the Selection List.

- Delete Rotations From List - allows removing all or a single rotation from the Selection List.
- Print Selections - provides options for printing the rotations in the Selection List.
- Manually Place Rotation On List - provides the entry of a single rotation number to the list.
- Time Calculator - displays the time/decimal calculator.

<table>
<thead>
<tr>
<th>Clear Selected Rqst</th>
<th>Clears all the current search parameter requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Saved Rqst</td>
<td>Uses the requests you saved from your previous session</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the database</td>
</tr>
<tr>
<td>Rotation Credit: 23:07</td>
<td>Displays total credit for displayed rotation.</td>
</tr>
<tr>
<td># found: 6</td>
<td>Shows how many rotations were found per the search requests.</td>
</tr>
</tbody>
</table>

To set a search parameter, click the appropriate parameter's box to activate it. Select from the Drop-Down list provided or enter time values where needed.
In this example we are looking for trips equal to or less than 3 day trip length.  We have also set the begin time to be 9:00am or later on the first day and a return time of 2:00pm or earlier on the last day of the trip.

Click on the trip length check box to activate.
Select \[\leq\] less than or equal to \[\geq\] equal to \[\geq\] equal to or greater than
Select the number of days from the combo box.

The Report and Release times can be set by clicking the appropriate item.
**Report Time**: Searches for time equal to or greater than the time entered.
**Release Time**: Searches for time equal to or less than the time entered.
Time values should include 4 numeric characters.  The values entered should follow the 24 hour time format shown on the rotations.
10:00am = 1000  3:45pm = 1545  9:30am = 0930

After you have the parameters set, click the **Begin Search** button to begin the search.

The first rotation of the search request will display in the window.  You can scroll through the rotations by using the keyboard arrow keys or by mouse-clicking the scroll bar arrow buttons.

Scroll through ALL of your **Selection List** rotations any time.
BUILD CALENDAR Function

Click on the **BUILD CALENDAR** tab to display the Build Calendar screen. This screen can be used to try different rotation combinations on the Build Calendar display to help you determine how you wish to bid. All rotations are available. You may also view only rotations you placed in the Selection List.

To place a trip on the calendar, place your mouse pointer over the rotation number on the **Trip Grid List** and hold down the left mouse button. Drag the trip to the date on the Build Calendar and release the left mouse button.

Display Trip Dates information is also on page 45.
Placing Rotations on Build Calendar and Saving the Calendar

Click a day on the mini calendar to display trips available for that day. Clicking calendar day 23 shows rotations available for that day on the Trip List Grid. Double-clicking the mouse over trip 1055 will display that trip's information in the Rotation Display at the bottom.

To place the trip on the calendar, place your mouse pointer over the rotation number 4083 on the Trip Grid List. Hold the left mouse down. Drag the trip to calendar day 8 on the build calendar and release the left mouse button. As you place trips on the build calendar, the total credit for the calendar will display at the top of the calendar.

This calendar has not yet been named. The default name is Create New Calendar.

When you are ready to save this calendar, click the Edit menu and select Save Calendar.

Enter a unique name for this calendar in the box and click the [OK] button.

The calendar will be saved and the title of the calendar will be placed within the Calendars menu at the top of the calendar.

The title at the top of the calendar will be changed to reflect the name you entered.
Miscellaneous BUILD CALENDAR Controls

- **Remove Rotation From Calendar** - removes highlighted rotation from calendar.
- **Delete This Calendar File** - removes entire calendar from the display and the deletes filename from computer.
- **Clear Entire Calendar** - clears the existing rotations from the displayed calendar.
- **CALENDAR EVENTS** – used by flight attendants for placing A-Days on the build calendar. Also used by pilots and flight attendants to enter comments or work events ie: vacation, training, other pay and non-pay events (p.29).
- **Reset Calendar to Last Saved** - changes calendar display back to the previous calendar last saved.
- **Check 30 in 7 Legality** - checks calendar for any Pilot legality problem associated with domestic rotation placements. Applies to the displayed calendar month only not between trips in two adjoining months.
- **Insert Comment** - allows placement of comment blocks on calendar using the CALENDAR EVENTS function.
- **Copy this Month’s Schedule to Build Calendar** - places existing Main Calendar data into a Build Calendar. This could be used if you are attempting to add a rotation from open time and want to see how it affects your monthly schedule, e.g., check 30 in 7 legalities.
- **Print** - options for printing one or all of the Build Calendars (p.72)
- **Save Calendar** - saves displayed Build Calendar.
- **Time Calculator** - displays a time/decimal calendar (p.63).

---

Checking for 30 in 7 Legalities on the Build Calendar

In Build Calendar, after placing trips on the calendar, you can check the domestic trips for 30 in 7 by right-clicking anywhere in the Build Calendar or by using the Edit menu.

If any problems are found, a list of the rotations will display. This procedure does not account for International trips.

If no problems are found, a trips Ok message will display.
This procedure will allow the viewing of all trips placed on the selection list on a calendar. Click the Display Trip Dates button on the build calendar. (Also, see bottom of page 42)

The rotations that apply to a day on the calendar will be displayed on that date.

**NOTE:** Due to the limitations of the display, a max of 18 rotations can be displayed per calendar day. Any excess over 18 rotations will have a star to the right of the calendar day number -- 20°.

The length of the rotation will be noted as different colors. At the bottom of the screen is a legend of the colors used.

A printed copy of the displayed screen is available by clicking the [Print] button.

Click the [Close] button to remove the display.
TRANSITION ROTATIONS – Month-End Trip Changes

When the program completes the conversion process of converting the Bid Package to the program’s format, the program will automatically look for any transition rotations that may affect your previous month’s calendar.

With this automatic feature, if you have trips located at the end of the previous month’s calendar and a message was not displayed telling you of a transition change, you should double-check. Manually read the BID PACKAGE Transition section to make sure none of your calendar’s month end-rotations have transitioned.

Manually Check for Transition Change

In the event you are displayed a message of a transition change, but you pressed the [Cancel – Do Not Change] button, you can still have the program recheck your previous month’s calendar for the change.

Display the calendar month you wish to check. On the Calendar_Procedures menu, select Check for Month End Transition Trips.

Transition Change Conversion

If a transition change is found, a display will pop up showing your rotation and how it has transitioned. Select the [Change] button to allow the program to make the change for your Calendar. A yellow WARNING advises that personal entries in days of the current rotation, that are not in banners, will be removed. Your original rotation will then be removed from the calendar and replace with its Transition rotation.

Selecting [Cancel – Do Not Change] does not remove the transition trip from the program. It closes the notification window and leaves the calendar unchanged.
After you have accepted this change, if your transition rotation also continues into the next month, a pop up will show you the trip’s pay credit for both months. The Time Calculator is available to confirm the Current and Next time values.

---

The top of the rotation display shows it is a **Transition Trip**.
It also posts the rotation # it is replacing.

---

Bid Assistant displays a rotation that spans two months by using a **WHITE** banner with **RED** lettering. Trip #T028 spans two month, 3 days in JUL, 3 days in AUG. It transitioned into #T503 which also spans 2 months. The banner shows it’s pay as 18:19 for the originating month.

---

#T503 carries 17:05 into the AUG calendar.
TRANSITION and NEW Rotations Added to Database

When Bid Assistant Converts the Bid Package, if it finds month-end Transition and NEW (need to cover) Rotations, the program places them in the prior month’s **Available Rotation List**. To access and use these newly added trips, the program requires you to Rebuild Rotation Database for the prior month.

A “– t” added to a rotation number in the Available Rotation List designates it as a Transition or a New trip. The – t does not display on the Main Calendar but does show in Search Request and Build Calendar.

This notice appears if the Available Rotation List has any Transition Rotations.

The trip display shows the rotation number without Bid Assistant’s “– t” designator.

**“Transition Trip”** notice displays to identify a transition trip when viewing a rotation.

Shows the replaced rotation.
CANCELLED ROTATIONS

Some bid packages will contain a list of rotations that have been cancelled for the previous bid month – (Cancel no repl.) The Bid Assistant program will notify you about all the cancelled trips, notify you if your calendar contains any, and will help you remove the rotation from your previous calendar and update credit values for affected calendars.

After the bid package is converted, the last message shown after the Transition Rotation notification will be the Cancelled Rotations Notification for the previous month.

Work Rules for Cancel no repl.
If the program finds your calendar has a rotation that has been cancelled, you will be advised of this and presented with a list of flight attendant work rules and options.
Cancelled Removed - Orange Banner Reminder

If you select to have the program remove the cancelled rotation, an orange banner will replace the rotation’s colored banner showing the credit value that was subtracted from the calendar’s monthly total.

If the rotation carried over to the next month’s calendar, you would not see the orange banner on the bid days of that month because the rotation has been removed. If there was any credit value that carried over to that month, the credit value would be subtracted from that calendar’s Monthly Total.

If you attempt to place a rotation/event over the orange Cancelled banner, you will be advised to remove that banner. This is so you can make note if necessary of the credit value lost. If you needed it on the calendar, you could place this info in a comment banner.

To delete a Cancelled orange banner, right click over a date the banner resides and select DELETE Banner: XNCLD –> xx:xx

Deleting this banner does not affect the Monthly Total as it has already been adjusted when the rotation was cancelled.
ADD–EDIT ROTATION

The ADD–EDIT Rotation procedure allows you to EDIT an existing rotation or ADD a new rotation to the displayed calendar Available Rotation List. You will also be able to edit a rotation placed on the calendar and tag it to the start date of that rotation. Rotations added or edited using the ADD–EDIT Rotation procedure will have a “dashed” number or letter attached to the end of the rotation name.

These examples compare Delta’s rotation formats to the Bid Assistant format. The pilot rotations are the same but do not have the Service or LF column or the number of flight attendants required for the trip.

DELTA BID PACKAGE

Delta Bid Packages display multiple rotations per page in two columns. The trip operation days are labeled with letters.

Each day’s totals are in the hotel line or following all legs flown for that day.

The bottom line shows the rotation totals.

BID ASSISTANT

ROTATION DISPLAY

The Bid Assistant display uses COLOR. The trip days are labeled using the trip’s day number, not letters. The Turn+ column shows layover time and time between legs.

Each day’s totals are in the hotel line or following the legs flown for that day.

The bottom green line shows the rotation totals.

iCREW DISPLAY

AFTER ROTATION IS FLOWN

The iCrew display shows the actual date flown for each leg. It also shows the FAR On-Duty times, actual (ACT), scheduled (SKD), maximum (MAX). Before the rotation is flown, aircraft passenger loads are shown. After flown, passenger loads are removed and all times are updated.

Bid Assistant’s ADD–EDIT Rotation function allows you to edit your trip to show exactly how you flew it on that specific date. If you made time, the Main Calendar’s Credit total increases when this edited trip is placed on the calendar.
Matching iCrew Information to the ADD-EDIT Rotation Display

Flight Attendant Layout

In Main Calendar, Edit > ADD-EDIT Rotation, opens EDIT Rotation screen

The dashed date number on the rotation name sets the date of this rotation. >> Operation Date change not allowed <<<

Use EX for TAFB

The Day Totals are in the iCrew hotel line except On-Duty times

Printed by AccuPrinter

Page 52
Putting Bid Package Information into the ADD-EDIT Display

Flight Attendant Layout

Should the program fail to properly format a rotation from the Bid Package, use the ADD-EDIT Rotation function to ADD the rotation to the Available Rotation List so it can be used in Search Request and Build Calendar.

Note: ATL 11:45 layover time is not entered in the Hotel Line Edit window, but in flight 101's Trip Line Edit window Turn+ box.

The dashed date number on the rotation name sets the date of this rotation. Operation Date changes not allowed.

#2015 in the Bid Package
ADD-EDIT Rotation Screen - Overall Display
The overall display shows all the information about the rotation. Any adjustments or additions to the rotation are done from this screen.

Rotation Operation Date(s) Calendar. Operation date(s) are selected by double-clicking each date which highlights in yellow.

Calculating
Click to use. Time values can be copied from the calculator and pasted into a time value box.

Main body of the rotation containing the legs and hotels
The line of BLUE times are totals for the last day.

The black arrow on the left side of the display indicates the Active Line.
Double-clicking an EDIT Rotation line opens the Edit Line window.

Total credits for the rotation
Activity buttons associated with the “Main Body” of the rotation.
Insert Line – Inserts a blank line after the active line.
Delete Line – Deletes the active line on the rotation.
Copy Line – Copies active line.
Cut Line – Cuts information on the active line leaving it blank.
Paste Line Data – Pastes a copied line onto the active line.

Copy/Paste:
If you copy a time value from the calculator, double click the time value box into which you wish to paste the copied time value. Click the right mouse button and select paste from the list.

Each line in the rotation represents a leg of the trip or a hotel entry. Adding extra lines to the rotation is accomplished by selecting the [Insert Line] button. Double-clicking a blank line will open a blank Edit Line screen to select the type of information (Trip Line or Hotel Line) for that new line of the rotation.

>> EDITING NOTE <<
All time entries entered should be at least 4 numbers long (no colon) – 4:15 = 0415 – except for the Turn+ and TAFB times which can have up to 6 digits. The program will automatically change the entries to the time “colon” value: 0415 → 04:15.

When changing an entry box value on the rotation and edit screens, the original value will be cleared for the new entry. If you decide not to change that value, pressing the [ESC] key on the keyboard will restore the original value.
The Rotation Leg Edit Screens

Double clicking the Active Line, on the main body of the ADD-EDIT display, will open the Edit Line screen.

**Trip Line and Hotel Line** options are used to activate their associated data entry

**Hotel List:** When in the Hotel Line option, selecting the [Hotel List] button will display a list of hotels. Double clicking the hotel on the list will place that information in the "City" and "Hotel" data boxes. You may also manually enter the data into the City & Hotel boxes.

**Flight Attendants Only**
Selecting the Charter box will remove the data entries under the SVC and LF columns and supply a larger entry box for the charter information.

**Calculator**
Click to use. Time values can be copied from the calculator and pasted into a time value box.

If you wish to change the type of entry (e.g., change a Trip Line to a Hotel Line), click the option button to activate that area of the Edit screen. **Note:** If you’ve entered data, selecting a different option button will remove that data.

When selecting the [Save] button, the information on the edit screen will be sent back to the rotation display and overwrite the current data on the “Active” Line selected. The colors of the rotation trip line will be adjusted to the type of entry sent back. Selecting [Cancel] will return you to the rotation display without making any changes to the “Active” Line on the rotation’s main body.

**NOTE:** The current data on the Edit Line screen will be sent back to the main edit’s “Active Line” display when selecting the [Save] button. The information that was originally on the rotation display will be replaced with the information you entered on the Edit Line screen.

**NOTE:** The Last Trip Line Totals are located at the bottom of the rotation display and are fixed in this position.

The blue time values on this line show the totals for the last day, same as the Hotel line without the hotel info. The black CRD time shows any additional time needed to adjust the CREDIT total.
All ADD EDIT Rotations placed in the calendar’s Available Rotation List are available to be used on all calendars, in the database procedures, and can be edited. This can be useful if the program had problems converting a “Delta” rotation to the Bid Assistant format during the Conversion of the monthly Bid Package.

- **ADD**ed rotations, whether they are brand new or use an existing rotation as a template, will have -A attached to the end of the rotation name, for example, Q010-A. You can convert any Delta rotation to the COLOR enhanced Bid Assistant format by using the [ADD Rotation] button function.

- **EDIT**ed rotations will have a dashed designation attached to their rotation name.
  - Edited rotations with NO specific start date will have -E attached to the end of the rotation name.
  - Edited rotations that are anchored to a specific day on the calendar will have a dashed number that has the start date attached to the end of the rotation name. Example: Rotation #3228 is edited and is only specific on the 28th of the month, the edited rotation number generated will be 3228-28.
  - Edited rotations that are used as a template for a Dupe (duplicate) rotation will have -D with the dupe number attached to the end of the rotation, e.g., 3429-D1.

- **Editing a displayed rotation on the calendar** will automatically place that rotation’s start date to the end of the rotation name, i.e., 4545-08.

**Special Note:** The dashed numbers will tell the program that these are additional trips that were added or edited after the Bid Package was converted. If you are required to CONVERT BID PACKAGE again due to a major program change, these added trips will be retained and available for use after the conversion.

**EDITing Rotations – Step by Step**

**Accessing ADD-EDIT Rotation:**
In the Bid Assistant Main Calendar, select the Edit menu then select ADD-EDIT Rotation from the list.

The first screen to appear will be the type of procedure you would like to do. Enter a rotation number you wish to edit in the rotation box. If the rotation number contains a “dashed” number, include it also with the name. The next screen will ask if this rotation is a Dyped rotation.

To Edit a rotation, type the rotation number or select it from the drop down list. Then click [Edit Rotation]

Check this box if the rotation will be a Dyped rotation. Then select [Continue].

Opening Screen
If rotation is **not a Dyped** rotation, you can select a rotation begin date from the list. Otherwise leave the combo box blank. Select [Continue].

Telling the program this is a Dyped rotation
If this rotation is a Dyped rotation, from the drop-down list select the Dupe number assigned to it by Delta, then [Continue].

**TRANSITION TRIP REMINDER:** If you wish to change or add a transition rotation, you will need to change the calendar display to the month the rotation begins.
IF you need to select multiple operation dates, leave the combo box blank and select [Continue]. A “-E” will be attached to the end of the rotation e.g., 3228-E. When the EDIT Rotation screen opens, you can select all the dates this edited trip operates. The original 3228 trip will still exist unchanged. You will now have rotations 3228 and 3228-E.

IF you need only one specific operation date, select it from the drop-down combo box presented on the second screen and click [Continue]. It will be attached to the end of the rotation name as a dashed number e.g., 3228-28. The EDIT Rotation screen’s calendar will have that date highlighted with yellow. No other dates can be selected. You can change the length of a rotation if necessary.

IF it is a Duped rotation, place a check in the displayed box. Select [Continue]. A screen will appear allowing you to select the number associated with this Duped rotation. Note: A number must be selected for the Duped rotation. Selecting [Continue] will take you to the next screen. The EDIT Rotation screen’s calendar will have that date highlighted with yellow. No other dates can be selected. You can change the length of a rotation if necessary.

Note: Dupe rotations can only be created from the Main Calendar Edit menu > ADD-EDIT Rotation.

Editing a rotation from the Edit menu will not make changes to the Main Calendar. To have an edited rotation replace an existing rotation on the calendar, you will need to remove the existing rotation from the calendar, then drop the edited rotation on the calendar from the available rotation list. However, editing a rotation that is on the calendar, by right clicking one of its days, WILL make changes to the Main Calendar. Please understand the WARNING in the next section before you use this right-click edit.

EDIT a Rotation that is on the calendar
Click the Right mouse button over one of the days of the rotation. Select “Edit Rotation # that begins on MMMdd”. This will make a new rotation specific to the start date of this trip shown on the calendar. The rotation will have the start date added to the rotation name as a dash number.

WARNING: This new rotation when saved will automatically replace the current rotation you have on the calendar. Your personal entries added to each day box will be overwritten by the rotation data. If you wish to keep your personal entries, they must be saved by you. Write them down OR copy the day entry into one of the Calendar’s unused days.

KEYBOARD DRAG & DROP SHORTCUT: Mouse-click the date you wish to copy, press and hold down the CTRL key, press and hold down the mouse’s left button inside the DATA to copy then DRAG the cursor to an empty calendar day box. When you release the left mouse button, the information will automatically PASTE into that empty calendar day box. After Bid Assistant replaces the old rotation with the new edited rotation for that specific date, CTRL-Drag the info back into the day you want to overwrite. To easily remove all information from a calendar day, CTRL-Drag a blank day into a day you wish to overwrite with blank information.

Make the appropriate changes required to the rotation. You can change the length of the rotation to reflect the changes if necessary. Once you have finished, select [Save]. The edited rotation will automatically replace the original rotation on the Main Calendar. Remember the WARNING above.

ADDING a NEW Rotation by Copying an Existing Rotation
Select the Main Calendar’s Edit menu, then select ADD-EDIT Rotation from the list.
After entering the new rotation number to added to the **Available Rotation List**, a second screen will appear allowing you to select the option on how to do it – use a blank sheet or copy another trip. After selecting the option click [Continue].

- **To use a blank sheet to add a new rotation** select that option. Then select [Continue]. This allows you to start from scratch and enter data for the new rotation. Select [Continue].

- **To copy an existing rotation**
  Type the number of the rotation you wish to copy or use the drop-down menu to select the rotation. Click [Continue] button. In this case Q010 is the Load Factor FA flying with FAs on trip #1003

**TIME SAVER:** It is easier to copy an existing rotation than to start from a blank sheet. More times than not there is another rotation that is almost identical to the new rotation you wish to ADD to the Available Rotation List. “Q” trips or Load Factor trips are the perfect examples. All times, aircraft, and pay are identical. The only differences would be the number of FAs, the operation dates, and maybe a DH - items easily changed using **ADD-EDIT Rotation**.

If a single operation date was selected for the new rotation, that operation date will be attached to the end of the rotation name with a “-” dash. Also, the edit screen **Operation Date(s)** Calendar will have only that date illuminated.

If an operation date was not selected for the new rotation, “-A” will be added to the end of the rotation number. An operation date or dates need to be selected on the **Operation Date(s)** Calendar. **Double-click** operation dates and they will highlight yellow.
Using a Blank Rotation Entry Screen
You can create a Bid Assistant display of a Delta rotation from scratch by selecting ADD Rotation, then Use blank sheet to add a new rotation. The process is similar to copying an existing rotation, but you'll have to enter all data manually. (This example creates rotation #1234.)

A blank ADD Rotation entry screen will appear for you to fill out.

The Check-Out time will automatically be added by the program based on the arrival time of the last leg or the rotation.

Double click a line on the rotation's main body to open the Edit Line entry window.

All data entry boxes will need to be filled in before saving the rotation.

All Operation Date(s) need to be selected. Double-click each date the new rotation operates.

Delta Bid Package rotations use letters to specify each day of the trip: A=1, C=3, etc. BA3 uses numbers. Click the Show Day List box for conversions.

Select: Trip Line or Hotel Line.

Double-click the desired day to put it in the Day box. To remove the list, uncheck the Show Day List box.
When the ADD Rotation screen opens, two (2) lines are blank. Legs 1393 and 1533 have just been added. To add additional lines to the rotation, select the active line that you wish to insert the line after and select [ Insert Line ].

To enter the Hotel information for this leg, click the "Hotel Line" option button to activate the Hotel entry.

Enter the rest of the rotation legs to the display. On the last trip leg of a day, if there are any “DH” dead head legs, place the dead head time value information in the Addl column.

Normally the actual block time for a dead head leg should be in the Block total box for that leg. When the program checks the TTL-BLK time, it will ignore any block time on a leg that has “DH” in the DH column’s box. The dead head’s credit time (DHD) is only located on the last leg for that day in the Addl column’s box.

Edit the "Last Trip Line Totals" to match the values shown on the Delta rotation display.
After you have finished the rotation entries, to display the completed rotation click the [Save] button. To exit the ADD-EDIT Rotation procedure without saving any of your entries or the rotation, click [Cancel].

When the completed rotation displays, check the rotation to make sure everything looks correct including the block totals and credit totals. No blank lines exist in the main body of the rotation except above the "Operation Dates..."

When selecting the [Save] button on the rotation displayed, the program will verify the totals before saving the rotation. If everything looks OK, the program will place the rotation in the displayed calendar month's Available Rotation List. The program will correct any errors it finds. The program will give you the option to save the rotation "as is" without making corrections.

Selecting [ Go Back and Edit ] will return you to the ADD-EDIT Rotation display if you need to make corrections.

If you are editing an existing rotation and add or remove lines from the rotation, make sure you verify and correct the time values associated with these changes.

Note: To enable the newly made ADD-EDIT Rotation to work in Search Request and Build Calendar, the database must be re-built.
The hotel list can be displayed by select **Hotel List** on the **Calendar_Procedures** menu.

A database file of layover hotels is included with the program. From time to time, this file will be updated to reflect the current layover hotels. The latest **Hotel List** will be included with most program updates. You can also manually update the hotel list by selecting the **HOTEL LIST EDIT** menu.

A hotel’s information can be displayed by highlighting the hotel’s line and either double clicking that line with your mouse or selecting **Edit** on the **EDIT** menu. This information can be changed by selecting the field and entering the required information. An entry box has been added to allow you to enter the limo phone number if one exists for this hotel. The limo information can be found on the rotation printout on the Deltanet site. When you print the rotation from the calendar, the limo name will be included with the printout.

Selecting **SAVE** will store the information of the displayed hotel and update the hotel list. Selecting **Add** on the **EDIT** menu will allow you to enter a new hotel on the list. To remove a hotel from the list, select **Delete** on the **EDIT** menu.

The Hotel List can also be displayed on the rotation “**Edit day**” dialog box.
The Time Calculator is unique for the Bid Assistant program. It is available on the Main Calendar and the database Build Calendar through the EDIT menu or by right-clicking within either of the calendars. This calculator has the ability to do calculations in *TIME FORMAT* and in *DECIMAL FORMAT*. A time value can be displayed in its decimal value equivalent, and a decimal value can be displayed in its time value equivalent. The keyboard numeric keypad can be used to enter data the same way a normal calculator is used. Note: Memory Keys MR, M+ and M- do not have keyboard equivalents available.

The calculator starts in the *TIME FORMAT*. Any values entered in this mode should be of a time value – 10:24. The calculator is operated by using the mouse selecting buttons on the calculator or by using the keyboard keys. Entries will be displayed in the Entry/Answer display box.

**Select Mode** changes the calculator's mode from TIME to DECIMAL.

**Display Decimal Value** displays the decimal value of a time value shown in the Entry/Answer box.

**Copy** displayed value for pasting somewhere else.

When MR is underscored (MR) a value is stored in memory and when clicked the value is pasted into the Entry/Answer display.

**Add** Entry/Answer box value to value stored in MR memory.

**Subtract** Entry/Answer box value from value stored in memory.

**Display Time Value** displays the time value of the decimal value shown in the Entry/Answer box.

**Copy** displayed value for pasting somewhere else.

A Time value displayed in the Entry/Answer box before selecting calculator in *DECIMAL FORMAT*, will be converted to a decimal value.

To enter a time value of 8 hours 5 minutes (8:05) – Click the [8] [:] [5] [0] buttons.

To enter a time value of 9 hours 50 minutes (9:50) – Click the [9] [:] [5] [0] buttons.

To change the calculator from the *TIME FORMAT* to the *DECIMAL FORMAT*, use Select Mode and select the option Use Calculator in Decimal Mode. If a time value is displayed in the Entry/Answer box, this value will be converted to a decimal value.
PROGRAM UPDATES - Downloading

From time to time changes will be made to the Bid Assistant program. These changes are available on the Bid Assistant web site www.ghale.com.

The program updates overwrite your existing program with the latest improvements. If you are having a problem with the program, you should check the web site's "What's New" first to see if this problem has already been addressed. It is highly recommended you check the web site each month for any changes made to the program.

What's New:
The web page’s What's New button details the changes made to the program.

If you already have the program installed on a computer and decide to change to a different computer, you will need to install the program on that computer with your program installation disk. BEFORE you run the program, download the latest program update.

PROCEDURE:
This example uses Goggle Chrome – The preferred method.

If the date of the program you are operating equals the date shown at www.ghale.com, you do not need to download the update. Your program’s Update can be seen on the program’s calendar page. Select <Help><About>. The date at the top of the dialog box shows your program’s Update.

The program Update will also show in the upper right corner of the calendar.

Program updates will be dated to identify previous updates in the event the current update causes errors in your program. The current update is always the top selection.

To begin, on the home page of the web site – www.ghale.com – select Program Updates.

The right hand side of this “Download” page shows the current update available.

Click on the date shown and the Bid Assistant Program Updates page will open.

[Program Update 09/26/2016]
UPDATES - Web Page Instructions

The Program Update screen will display when a date is selected. The date shown at the top of the list is the latest update. **Each update contains the changes included in previous updates.**

Windows Vista and Win 7

Occasionally warning messages may appear when trying to download the program updates. This is a normal function for Windows to protect your computer. Any download that is executable (.exe), Windows will advise you of the potential danger. The program update files are safe for you to install on your computer. The procedure below will help you install the program update. This example uses a Vista computer.

Select “Actions”
Select "More Options"

Select "Run Anyway"

Select the [Unzip] button

Click [OK] then [Close]
When attempting to download the program update on a Win10 computer, you will get an error message – “Can't create output file:..... “. The reason for this is the program was written before Win10 was released. To correct this you will need to run this program as an administrator. Since the file is not a permanent resident on your computer, you will need to do this procedure when ever downloading the program update from the web site.

Following the steps shown below should get you up and running.

Select the latest update from the list.

If this warning message appears, select "Keep"

The update will be downloaded to your computer “Download” folder. At the bottom of the screen the “ba_update” will be displayed in the status bar. Select the arrow to the right of the ba_update, then select “Show in folder”.

Right click the “ba_update_xxxxxxxx” to display a menu selection.

Select “Run as administrator”
After selecting “Run as administrator”, this warning will appear. Select [Yes] to continue.

User Account Control

Do you want to allow this app from an unknown publisher to make changes to your device?

Ba_update_xxxxxxxx_exe
Publisher: Unknown
File Origin: Hard drive on this computer

Show more details

Yes No

Click the [Unzip] button to extract the update files. When complete, select [OK] and then select [Close]

WinZip Self-Extractor - ba_update_03062017.exe

To unzip all files in ba_update_03062017.exe to the specified folder press the Unzip button.

Unzip to folder: 
GRAM FILES (X86)BID ASST3

Run WinZip

Browse...

Close

Overwrite files without prompting

Unzip

About

Help

WinZip Self-Extractor

8 file(s) unzipped successfully

OK

After you have extracted the update files, you can delete the ba_update_xxxxxxxx.exe file from the Download folder.
PERSONAL EVENTS – Birthdays, Anniversaries, etc

Yearly repeating events (birthdays, anniversaries, etc.,) will automatically show on your calendar in red print next to the day’s date. In Calendar_Procedures > Bid Assistant Setup, use the [Personal Events] option.

Add Personal Event

1. Enter a short description of the event.
2. Select the month and day of the event.
3. Clicking the [Add Event] button will place the event on the list.

Edit or Delete Personal Event

To show the Edit/Delete menu, double click the list item you wish to change.

Selecting Delete Event will remove the item from the list.

Selecting Edit Event will move the event up to the Description/Month/Day boxes.

Change the Description and or Month/Day. Click the [Edit Event] button to place the event back on the list.

After adding, editing or deleting an event click Save to keep the changes.

How Personal Event shows on calendar
MONTHLY ALERTS
Alert of events on the current month calendar.

**Monthly Alerts** allows the user to enter dated events for the displayed calendar. When the program is started and after the current monthly calendar displays, if **Monthly Alerts** have been placed for this month, they will display. The alerts only display for the current month when the program is started. The alerts can be edited by selecting **Monthly Alerts** on the **Edit** menu.

Click **Monthly Alerts** on the **Edit** menu to display the **Monthly Alerts** screen. The entry screen consists of a **description** box for placing the alert and a **date** list for selecting the date of the event.

A file menu is provided for various operations of the display.

- **Add new line**
  Places a new line on the form for placing an entry.

- **Delete selected line**
  Deletes the selected line from the display.

- **Save**
  Saves the current display and places the entries in dated order.

- **Close**
  Exits the Monthly Alerts procedure.

THE DISPLAY
After alerts have been added, they will be displayed when the program is started if they apply to the current month display.

The display uses color to highlight events.
MAXIMIZING the Calendar Screen

The Bid Assistant opening calendar is preset to a ‘Normal Window’ size so it does not occupy your entire monitor but can still correctly show a fixed font size for important items including two hotel listings on one date. With today’s smaller laptop monitors, many users wish to make the Bid Assistant window fill the whole screen. Windows desktop has the ability to set a program’s screen to 2 sizes. Here’s how to set Bid Assistant to open in the maximum screen.

Windows Vista instructions

1. On your desktop, right-click the Launch icon for Bid Assistant

2. On the displayed selection list, select Properties

3. In Properties, select the Shortcut TAB. At Run: the drop-down menu, when opened, will have 3 selections. Select Maximized. When finished click the [Apply] button, then the [OK] button.

Windows10 instructions

The Windows 7, 8 and 10 Icon may not be a shortcut icon, but changing to MAXIMIZED is almost the same. Right-click your mouse on the icon. If it produces a pop up with a Properties option, simply follow the above instructions.

However, the icon you right-click may not be a shortcut icon, so you need to instruct your computer to find the Bid Assistant start up icon.

If your right-click produces this option, select More for 3 more options. Select Open file location, a Windows Explorer window will open and you’ll see the icon.

Right-click this icon, select Properties and follow the above instructions.
PRINTING OPTIONS

PRINT CALENDAR
With your calendar displayed on the screen, in the Calendar_Procedures menu select Print > Calendar >

Select the printer.

Select one of the seven (7) print options.

NOTE: If you change the Default printer on the Bid Assistant Program’s Printer Setup, you will need to close the program then re-open the program for it to use the new selection.

In this example, the default printer is set to HP Photosmart C6200 series
Print Calendar with Rotation Information

Yearly Calendars - prints a year of calendars

Print Rotations Only

This printout is mainly for pilots but available for flight attendants. Selecting this will make a printout of each leg of the rotation. This can be cut into 6 legs per page.
Build Calendar Print Options

- Displayed Build Calendars – Prints a single displayed Build Calendar
- All Build Calendar Rotation Details – Prints the rotation details for each Build Calendar
- All Build Calendar Displays – Prints all Build Calendars. Displays 4 calendars per sheet.

Print a display showing the details of all your saved Build Calendars

Print the Build Calendar that is showing

Print all saved Build Calendars. This prints four (4) simple ink-saving calendars per sheet of paper.
EMAILING CALENDAR – Convert to PDF

Bullzip PDF Printer is a free program (www.bullzip.com/download.php) that can provide another option to printing your calendar and monthly rotations. After you have installed the program on your computer, select the Print procedure in the Calendar Procedures. Using the procedures shown below will allow you to create your calendar and rotation files as a PDF file. This file can then be attached to emails to share your schedule with others. iPhone users can email the PDF to their phone and then save the PDF file in iBooks. Smart phone owners can use its PDF reading app.

Finding and Installing Bullzip PDF Printer Software

Place the address www.bullzip.com/download.php into your computer browser address bar to open this page.

NOTE: After changing the Default printer on the Bid Assistant Program’s Printer Setup, you will need to close the program then re-open the program for it to use the new selection.
After the program is installed, the BULLZIP installation changes the default printer to **bullzip**. If you prefer your home printer as your default printer, here’s how to reset your **default** printer option:

Select the Start button then select Control Panel, Hardware and Sound and Printer.

![Control Panel](image1)

1. The default printer is **Bullzip PDF Printer**.
2. Highlight the printer you want as the Default Printer. When you right-click on it a menu of options will display. Select: **Set as Default Printer**.
3. ![Set as Default Printer](image2)
The default printer is the HP Photosmart C6200 printer.

NOTE: After changing the Default printer on the Bid Assistant Program’s Printer Setup, you will need to close the program then re-open the program for it to use the new selection.

PRINT CALENDAR
With your calendar displayed on the screen, in the Calendar Procedures menu select Print > Calendar >
Using Bullzip PDF Printer
Bullzip PDF Printer (free software available online) can create a PDF document you can attach to emails for viewing by your family & friends who have a PDF reader (e.g., Adobe Reader). It is used just like your home printer shown on the previous page. To use, select Calendar Procedures > Print > Calendar > ______, and the Print Setup window appears. In the Name window, find and select Bullzip PDF Printer.

Select OK to continue with the print process.

When you want to make a PDF document of your calendar using Bullzip PDF Printer, after you select Bullzip in the Name list in Bid Assistant’s Print Setup window, if already in the process of printing, you will have to cancel your printing so you can close and reopen Bid Assistant for Bullzip to print.

NOTE: After changing the Default printer on the Bid Assistant Program’s Printer Setup, you will need to close the program then re-open the program for it to use the new selection.
As it is creating the PDF document, Bullzip PDF Printer will automatically give it a name. Here’s how to change it.

To change the name of the PDF file you are making, click the … button on the right of the File Name box. Type a new name for this file, then click [Save].

In this example the file name set by the PDF Writer is C:\Users\owner\Desktop\Atlas2.pdf. The filename was changed to something more reasonable C:\Users\owner\Desktop\OCT2016.pdf. When you select [Save] the PDF file will be generated. You can now email this PDF file as an attachment to yourself or to other family members and friends.
Another Bullzip PDF Printer benefit is you can attach together two or more different PDF files to make one document. Continuing from the previous steps, now we will make a PDF printout of the Calendar and the Rotation Summary.

Calendar_Procedures > Print > Calendar > Rotations Only (Summary) creates the Rotation Summary page. On the Options menu select Print Rotations.

After selecting Print Rotations, the Bullzip PDF Printer “Create File” screen appears. In this example, I have already changed the name of the file from Atlas2 to OCT2016. Select “Merge”.

On the Merge screen select this “…” button to display available files. The previous OCT2016 calendar PDF file was saved on my desktop. We will merge it with the Rotation Summary display.

Click [Save] after you have attached the merged file. 

(...continued on the next page)
Since the calendar PDF was named OCT2016 and the new merge PDF file I am creating is also named OCT2016, a message may pop up asking if you wish to overwrite the existing file. I only need one PDF file so I let the Bullzip write over the existing calendar file. The PDF file generated is 2 pages now. First page is the 11x8.5 (landscape) calendar, the second page is the 8.5x11 (portrait) rotation summary. Page 2 portrait 8.5x11 picture shortened to fit here.

You now have a single PDF file that you can email to yourself &/or friends. You can open this file on your IPAD or IPHONE and then transfer the file to your iBooks or PDF programs.

Here's how you change your default printer from “Bullzip PDF Printer” back to your paper printer.

NOTE: After changing the printer on the Bid Assistant Program’s Printer Setup, you will need to close the program then re-open the program for it to use the new selection.